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1.0 Introduction 
HEAT tickets, also referred to as call records, provide a complete record of a 
problem, service request, or change request from a customer.  In addition it 
links each ticket with the customer’s profile to easily reference the contact 
information and call history for the customer.  The combination of ticket and 
customer history makes HEAT a very valuable tool for reports and analyzing 
past tickets.  

This document addresses two components of HEAT: 

  Call Logging: The HEAT application used to create, assign, track, and 
close tickets. 

  Alert Monitor: The HEAT application use to alert technicians when a 
ticket needs their attention. 
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2.0 Heat Tickets Overview 
2.1 When to Create a HEAT Ticket 

HEAT tickets should always be created for customers that report a problem, 
request a service, or request a change.  HEAT tickets should also be created 
when you want a record of a request and its fulfillment; or a problem and its 
solution. 

  In general, you should create a HEAT ticket when the request for service 
is on a non-recurring basis. 

  Always create a HEAT ticket for change requests – regardless of the 
source.  Change Management provides additional details concerning 
changes and customer notification requirements. 

  HEAT tickets do not need to be created when the customer is internal to 
OIT and the action resulting from the ticket is part of your daily duties.  
For instance, if you regularly create backups of a server you would not 
need to create a ticket.  However if you receive a special request to create 
a one-time backup from a customer (including in OIT), creating a HEAT 
ticket would be appropriate.  

  If you regularly provide system support to customers outside of OIT as 
part of your job description, then when you provide similar support to a 
member of OIT you should create a HEAT ticket.  For example, resetting 
a customer’s password. 

  HEAT tickets are normally not created for analysis, research, or project 
management tasks.  The rationale is that the immediate impact is not 
normally apparent to the customer. 
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2.2 HEAT Ticket Lifecycle 
While the assignments and actions for each ticket will be unique, each HEAT 
ticket will have a common lifecycle as shown in the following illustration. 

 

 

 

 

 

 

 

 

 

 

 

Figure 2-1: Flowchart of ticket lifecycle  

1. A request from a customer to solve an Information Technology (IT) or 
telecommunications problem, or to provide a service, initiates a ticket. 
This request is either made directly to the OIT Help Desk or submitted 
by the customer using the Help Self Service (HSS) web interface. 

2. Regardless of how the ticket is initiated, the OIT Help Desk reviews 
the ticket and makes the appropriate assignment. 

  If the help desk analyst is able to resolve the problem or request, 
the ticket is assigned to the help desk analyst.  

  If specific technical expertise is required, the help desk analyst 
assigns the ticket to the appropriate technician or office in OIT.  

  If the ticket is the responsibility of another unit’s IT support staff 
and that unit does not use HEAT, the help desk will forward the 
request to the unit using e-mail, close the ticket, and notify the 
customer of the change in assignment. 

3. Upon receipt of a ticket assignment, the technician must 
“acknowledge” the ticket within four hours of the assignment.  Alert 
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Monitor is a very useful tool to notify the technician when a new ticket 
is assigned.  The technician then performs the requested actions.  If 
applicable, the technician may create additional assignments if not able 
to resolve the ticket or service request alone. 

4. The technician updates the ticket to document the completed actions. 

5. Once the problem is resolved or the service request fulfilled, the 
technician contacts the customer to confirm the resolution, preferably 
by phone.  If unable to make contact with the customer by phone the 
technician should contact the customer via e-mail and document each 
contact attempt in a journal entry. 

6. The ticket is closed by the last technician to complete their assignment.  

7. If the customer receives IT support from the OIT, he or she will 
receive an e-mail when the ticket is closed.  The e-mail states that the 
ticket has been closed and tells the customer what to do if the problem 
has not been resolved satisfactorily.   

Customer Quality Survey 
For 20% of these closed OIT tickets, a Customer Quality Survey 
request is e-mailed rather than the standard notice.  The customer has 
the opportunity to rate OIT’s quality of service and timeliness.  All 
comments are reviewed by the OIT Help Desk.  In all cases, when the 
customer does not agree that the problem was resolved or service 
provided, the OIT Help Desk will reopen the ticket. 

Please refer to technical note Help Desk Ticket Escalation Procedures for 
additional information on the proper handling of tickets. 

2.3 Mandatory Fields 
When a ticket is created or closed, HEAT checks the ticket’s contents to make 
sure that all required fields and assignment have been completed.  If not, 
HEAT identifies which fields still need to be completed.  Required fields are 
denoted by an asterisk (*). 

2.4 Key Field Definitions 
It is especially important that the following fields on the Call Log tab in Call 
Logging are completed correctly for performance measuring purposes and to 
ensure that the tickets are resolved most expeditiously.  See the following 
table. 
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Field Name Definition 

Call Type The general nature of the problem.  Options include Change, Problem, Critical 
Problem, and Service. 

System What is impacted?  There are two simple options: Hardware or Software. 

Category Category refers to a more specific description of the hardware or software that is 
impacted by the issue. 

Sub-Category An even more specific description of the issue.  Options differ, depending on the 
Category selected above.  RPMS SW, NPIRS, E-mail are only a few of the options. 

Status The current status of the ticket in HEAT. 
• Open: A ticket that is either being actively worked or needs to be worked. 
• Closed: A ticket that has been resolved and no further action is required from 

any HEAT technician. 
• Monitoring: A ticket that is believed to be resolved, but the technician wants 

to monitor it for awhile to check the effectiveness of the ticket’s resolution 
before closing the ticket. 

• Deferred: A ticket where further action must wait for another action that is not 
eminent. 

• Reopened: A ticket that was previously closed and later found not be resolved.  
The original ticket is reopened to be worked for a final resolution. 

Source  The source that best describes how the customer requested a service or change, or 
reported a problem.  
• E-mail: The ticket is created based on the receipt of an e-mail from a 

customer. 
• Fax: The ticket is created based on the receipt of a fax from a customer (e.g., 

an account request form). 
• HSS: The ticket is generated automatically by the HEAT server when a 

customer creates a ticket using the Help Self Service web interface. 
• In person: The ticket is created when a customer makes a request or reports a 

problem in person to a HEAT tracker or technician.  An in person request often 
occurs when a customer alerts a technician to a new problem/request while the 
technician is at the customer's site working on another problem/request. 

• Phone: The ticket is created when a customer makes a request or reports a 
problem over the phone to a HEAT tracker or technician. 

• Self: When a ticket is created by the customer for himself/herself via Call 
Logging. 

• System Monitor: The ticket is created in response to an alert issued by a 
system monitor. 

• Voice Mail: The ticket is created based on the receipt of a voice mail from a 
customer. 

Owner The IT support staff that services specific Indian Health Service units.  Assign the 
ticket owner based on the customer’s unit not their location.  
• Units supported by OIT are listed on HEAT at http://www.ihs.gov/OIT/ 

helpdesk/support 
• If in doubt, choose OIT and the OIT Help Desk will reassign the ticket as 

appropriate.  
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2.5 Requesting HEAT Accounts and Training 
To request a HEAT user account or HEAT training, open a HEAT ticket.  
This can be done by contacting the OIT Help Desk by the following means: 

  Phone: 505.248.4371 or 888.830.7280 

  Submit a service ticket using Help Self Service at 
www.ihs.gov/helpdesk 

  E-mail a request to the Help Desk at www.ihs.gov/helpdesk 

  E-mail a request to the Help Desk at support@ihs.gov 

  Have someone with HEAT access create a ticket on your behalf. 

For new accounts, the request should include the name of the account holder, 
unit, and the HEAT assignment group.  If known, also list the alert monitor 
groups in which the account holder will need membership.  The request 
should also state that the HEAT Client be installed on the technician’s 
computer at the same time. 

2.6 Requesting Changes to HEAT 
The OIT Help Desk is interested in hearing any ideas you may have to make 
HEAT better or easier for yourself and others to use.  Please create a HEAT 
ticket to submit your suggestion to OIT User Support (IHS).  Submit the 
following: 

  Service ticket for requests to create a new Alert Call Group, create or 
modify a new report, request a new “Quick Call”, or adding new 
functionality for a subset of HEAT users. 

  Change ticket for requests to add values to existing pick lists; add new 
fields, or any other changes to the existing screens used by all HEAT 
technicians. 

For both types of tickets, include in the description the need that is driving 
your request. 

 

http://help.si.edu/
http://help.si.edu/
mailto:support@ihs.gov
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3.0 Installing the HEAT Client 
Navigate to the following file share:  \\npaheat01\Install Files\HEAT.  

Run:   ODBCWizard.exe 

3.1 Installation Types 
This manual focuses on installation via use of the HEAT Open Database 
Connectivity (ODBC) Wizard.  However, HEAT may also be installed by 
other means as described in the following section. 

Two installation types are available as follows: 

Administrative Installation: Creates an image of the HEAT installer 
(usually on a shared network drive) from which end users can install to 
their local workstations.  Running the End-User installation using an 
administrative image also simplifies future upgrades and patches. 

Important: An Administrative installation makes an exact 
copy of the HEAT installer on the network location you 
specify. 

End-User Installation: Installs program files to an end user’s workstation.  
(Users have the option of selecting either a Typical or Custom 
installation.)  You can run this type of installation from either an 
administrative image on a shared network drive. 

3.2 Setup Types 
Two setup types are available for End-User installations: 

Typical: Installs HEAT’s most common features, including Call Logging, 
and Alert Monitor. 

Custom: Allows the user to select specific modules and features for 
installation.  The default installation of HEAT installs all features typical 
for a system administrator and/or manager. 

3.3 Tips for Administrative Installations 
Exit all programs running on your system.  This frees memory and alleviates 
potential conflicts between the installer and other software on your computer.   

Install HEAT to a shared network drive.  This installs an administrative image 
of HEAT to a shared location.   
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Note:  You must have Microsoft Windows Installer Service 
installed on your server in order to distribute HEAT to 
workstations by way of your server.  If the HEAT installer 
does not find this program, it installs it.  The installer 
prompts you for a reboot, if required. 

3.3.1 License HEAT 
Licensing registers HEAT and its numerous modules.  Licensing is conducted 
through the Administrator module. 

3.3.2 Quick Start Wizard 
Configure your HEAT Database using Quick Start Wizard.  Quick Start 
Wizard is a tool that helps first-time HEAT administrators initially customize 
a database to meet OIT’s specific needs.  The wizard helps create things such 
as Call Types, Configuration Types, and fields. 

3.3.3 HEAT ODBC Wizard 
Use the HEAT Open Database Connectivity (ODBC) Wizard.  You can 
distribute your ODBC data source for use on an end user’s computer by using 
the HEAT ODBC Wizard (located on the HEAT Installation CD).  

Note:  The HEAT ODBC Wizard does not map drives or 
perform driver-specific configurations.  If your data source 
requires any special system configuration, this should be 
resolved before you install HEAT. 
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4.0 Alert Monitor:  Step-by-Step Instructions 
Alert Monitor is a separate HEAT software application from Call Logging.  It 
serves as a notification and monitoring tool for both technicians and 
managers. 

Call Groups 
Tickets are managed in Alert Monitor through the use of Call Groups.  Call 
Groups identify tickets with similar attributes – such as all open tickets 
assigned to a particular technician.  Call Groups also control when you want 
to be notified of a new ticket that meets the call group’s criteria.  For example, 
send a notification when a new ticket is added to the call group.  

Technicians must be logged into Alert Monitor to receive the notifications.  
OIT recommends that all HEAT users either keep Alert Monitor open or 
minimized on their computer’s desktop whenever they are using their 
computer. 

4.1 Login Steps 
To login to alert monitor:  

1. Double click the Alert Monitor icon on your desktop. 

 

 

Figure 3-1: Sample of Alert Monitor icon 

2. If your HEAT account does not match your Active Directory (AD) 
account ID, or if do not have an AD account, you will have to enter your 
HEAT User ID and Password as shown in the following screenshot.  

3. If your HEAT account does not match your AD account ID, or if do not 
have an AD account, contact the OIT Help Desk to have your HEAT ID 
modified to match your AD account ID. 

HEAT v8.4 User Guide 9 Alert Monitor Instructions 
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4.2 Open a Ticket 

4.2.1 Steps  
Take the following steps to open a ticket from within Alert Monitor. 

1. Select a call group from the dropdown box.  For example All Active Calls 
appears in the dropdown box in the following example.  See Call Group 
Details.   

 

 

 

 

 

 

 

Figure 3-3: Sample of using Alert Monitor 

2. Double click the call record for the ticket you wish to open. 

The ticket opens in the HEAT Call Logging window.  See the following 
screenshot.   

icket opens in the HEAT Call Logging window.  See the following 
screenshot.   
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Figure 3-4: Sample of a call record 

4.2.2 HEAT Technician Minimum Call Group Requirements 
We recommended that each HEAT technician have at a minimum the 
following call groups: 

  Open critical problems 

  Open assigned to them – set to generate alerts when calls/tickets are added 

  Open assigned to their group 

  Unacknowledged assigned to them – set to generate alerts when 
calls/tickets are added 

  Unacknowledged assigned to their group (team) 
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4.3 View Assignments  
From within the Alert Monitor you may view all the active and completed 
assignments for an individual ticket. 

4.3.1 Steps 
To view the assignments for a ticket: 

1. Click the ticket, located in the upper pane, for which you want to view the 
assignments.  

2. The selected ticket’s assignments appear in the lower pane. 

 

 

 

 

 

 

 

 

Figure 3-5: Sample of viewing ticket assignments 

3. To view additional assignment details, scroll to the right.  

4. To change the sort order, click the column heading to toggle between 
ascending and descending order. 

5. To resize the columns, move the mouse over the column heading division 
lines until its shape turns into a double-headed arrow.  Click and drag the 
division line to resize the column. 
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To save your column resizing, you must click the Save icon shown following.  
This only saves the columns for the selected alert group.  To change the 
column widths in your other alert groups, repeat the column resizing for each 
of them individually. 

 
 

Figure 3-6: Sample of Save icon 

4.4 Open Call Logging 
For steps on how to open a specific ticket in Call Logging from within the 
Alert Monitor, please refer to the Open a Ticket section of this document. 

To Open Call Logging from within Alert Monitor use the following steps. 

4.4.1 Steps 
1. Click on the Launch Call Logging icon, as shown following. 

 

 

 

 

 

 

 

 

 

 
Figure 3-7: Sample of launching call logging 
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2. Call Logging appears in a new window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 3-8: Sample of window displaying call logging 

4.5 View Journal Summary 
From within the Alert Monitor you may view a summary of the journal entries 
created for a specific ticket.  Please note that if you want to see the complete 
journal entry, you will need to open the ticket in Call Logging.  (Double click 
the ticket number to open the ticket in Call Logging.) 

4.5.1 Steps 
To view the journal summary for a ticket take the following steps: 

1. Click the ticket located in the upper pane for which you want to view the 
journal summary.  See Figure 3-8 shown previously. 
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2. From the menu bar, select View > Journals. 

3. A summary of all the journal entries appears. 

4. To view the journal entry text, scroll to the right to see the first part of the 
journal entry.  

5. To change the sort order, click the column heading to toggle between 
ascending and descending order. 

6. To print the journal summary, click the Print button.  Be sure to change 
the paper layout to “landscape” in the print dialog box. 

 

 

 

 

 

 

 

 

 

 
 
 

Figure 3-9: Sample of journal window 

4.6 Call Groups Overview 
Call Groups put together tickets with similar attributes – such as all open 
tickets assigned to a particular technician.  Call Groups also control when you 
want to be notified of a new ticket that meets the call group’s criteria.  Most 
likely when your HEAT account was created, default call groups were 
assigned to your login account. 

There are three categories of Call Groups as follows: 

Personal 
Call groups that you create for your use only.  They are private and cannot be 
shared with other HEAT technicians. 
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Team 
Call groups that were setup for use by HEAT technicians that belong to the  
same HEAT Group.  

Global 
Call groups for use by all technicians. 

4.7 Add an Existing Call Group 
When you log into Alert Monitor, it automatically opens the call groups saved 
in your profile.  You may add an existing Call Group (one that was previously 
defined by you or the HEAT system administrator) to your profile. 

4.7.1 Steps 
To add an existing call group, take the following steps: 

1. Click the Start/Stop Polling icon to stop the polling for new tickets. 
Polling must be turned off while working with call groups. 

 
 

Figure 3-10: Sample of Start/Stop Polling icon 

When polling is on many of the menu and toolbar options are grayed out, 
as shown in the following example. 

 

Figure 3-11: Sample of tool bar with unavailable options 

2. Click the Define call group alerts icon.   

 
 

Figure 3-12: Sample of Define call group alerts icon 

A window opens displaying your currently selected call groups. 

3. Click the New button. 
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Figure 3-13: Sample of window displaying currently selected call groups 

4. The Define Call Group Alert window appears.  Click the Browse button. 

 
Figure 3-14: Sample of window showing Browse button  

5. Select the radio button corresponding to the type of Call Groups you wish 
to browse, as shown in the next example.  These options include the 
following: 

  Personal: Call groups you created for yourself.  Please note that 
you will only see your own alert groups. 

  Team: Call groups created by the HEAT System Administrator 
specifically for your team (HEAT Group) members. 
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  Global: Call groups created by the HEAT System Administrator 
available to all HEAT users.  Please note that if a call group will 
be used by more than one team, it must be stored at the global 
level. 

  All: All of the above. 

 

 

 

 

 

 

 

 

 

Figure 3-15: Sample of window showing call groups that can be browsed 

6. Click the name of the call group you want to add your profile. 

7. Click the Open button.  You will be taken back to the Define Call Group 
Alert window. 

8. The Define Call Group Alert window allows you to choose when to 
Generate an alert if….  Select one of the three options provided by 
clicking the check-box as shown in the following example.  You may 
choose: 

  Any Calls are Found 

  Calls are Added 

  Calls are Removed 



Indian Health Service Office of Information Technology       v1.0 

HEAT v8.4 User Guide 19 Alert Monitor Instructions 
October 2008 

 

Figure 3-16: Sample of screen used to define a call group alert 

9. Click the OK button. 

10. Click the Exit button. 

11. Click the Save icon. 

12. Click the Start/Stop Polling (traffic signal) icon to turn on polling. 

 

4.8 Change a Call Group’s Alerts or Display 
Preferences 
Call Groups may be customized to match your preferences.  At any time, you 
may change: 

  When you want to be notified of a change in your call group 

  The type of information displayed about each ticket in your call group (the 
grid layout) 

These changes only affect your display – not anyone else’s.  You may 
therefore change any personal, team, or global call group preference. 
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4.8.1 Steps 
To change a call group’s preferences, take the following steps: 

1. Click the Start/Stop Polling icon to stop the polling for new tickets. 
Polling must be turned off while working with call groups. 

 

Figure 3-17: Sample of Start/Stop Polling icon 

Remember – when polling is on many of the menu and toolbar options are 
grayed out. 

2. Click the Define call group alerts icon.  

 
 

Figure 3-18: Sample of Define call group alerts icon 

3. Click the alert group you want to edit.  See the following example. 

 

Figure 3-19: Sample of choosing an alert group for editing 

4. Click the Edit button. 

5. Choose when you want to be notified of a change to the call group from 
the Generate an alert if options. 
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Figure 3-20: Sample of alert notification options 

6. To change the summary information that is displayed in the Call Group 
window, click the Grid button.   

7. The Grid Definition window appears.  To add a field, click the field’s 
name in the Available Fields column then click the Add button.  See the 
following example. 

 

Figure 3-21: Sample of Grid Definition screen 

8. To remove a field, click the field’s name in the Selected Fields column 
then click the Remove button. 

9. To change the order of the selected fields, click the field you want to 
move.  Then click either the Move Up or Move Down button to 
reposition the field. 
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10. When you have finished making your changes in the Grid Definition 
window, click the OK button. 

11. Click the Save icon. 

12. Click the Start/Stop Polling (traffic signal) icon to turn polling on 
again. 

4.9 Create a New Personal Call Group 
The instructions below show how to create a Personal Call Group.  Personal 
call groups are private and cannot be shared with other HEAT technicians.  

If you need a Global or Team Call Group created, contact the OIT Help Desk 
or create a ticket to request this service.  Global and Team Call Groups may 
only be created the HEAT System Administrator. 

When you create a Personal Call Group, you are actually using Boolean logic.  
If you already understand that, you will recognize it in the steps described in 
this section.  Just follow the steps provided.  If you need additional 
information or would prefer to have the HEAT System Administrator create 
your personal call group, then contact the OIT Help Desk for assistance. 

 

4.9.1 Steps 
To create a new call group, take the following steps: 

1. Click the Start/Stop Polling icon to stop the polling for new tickets.  
Polling must be turned off while working with call groups. 

 

Figure 3-22: Sample of Start/Stop Polling icon 

Remember – when polling is on many of the menu and toolbar options are 
grayed out. 

2. Click the Define call group alerts icon.  

 
 

Figure 3-23: Sample of Define call group alerts icon 

3. Click the New button.  See the following example. 
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Figure 3-24: Sample of screen used to create a new call group 

4. The Define Call Group Alert window appears.  Click the Browse button 
as shown in the following screenshot. 

 

Figure 3-25: Sample of screen used to create a new call group 
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5. The Open Call Group window appears.  Click the Add button, as shown 
in the following example.   

 

 

 

 

 

 

 

 

 

 

 

Figure 3-26: Sample of screen used to create a new call group 

6. In the Name box, type the name of your Call Group.  It can be called 
anything you want. 

7. In the Description box, type a brief description of the Call Group. 

8. Click the Personal radio button.  See the following example. 
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Figure 3-27: Sample of entering new group information 

9. The next step involves defining the criteria (expression text) that the 
tickets must meet to appear in the new call group.  Boolean logic is used 
to create the criteria for determining which tickets should appear in the 
call group.  Following is a short primer.  If you need additional help, 
then click the Help button or contact the OIT Help Desk for additional 
assistance. 

  Table Name: Displays the HEAT tables (generally the tabs 
displayed on a ticket) and @functions (e.g., the @current date) 
available for use.  When you select a table, the available fields 
for that table appear in the Field list. 

  Field Text: Displays the fields available in the selected table.  

  Operators: Operators are used to define the condition the 
selected field must meet.  Note the information in the following 
table. 
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Operators and Definitions 
= Equal to  <> Not equal to 

< Less than  > Greater than 

<= Less than or equal to  >= Greater than or equal to 

Is empty Nothing is entered in the 
field 

 Is not 
empty 

Anything is entered in the 
field 

Is null Nothing is entered in the 
field 

 Is not 
null 

Anything is entered in the 
field 

Like Contains the specified value anywhere in the field 

Figure 3-28: Table of operators and definitions 

10. To create an expression: 

  Choose a table containing the field you want to add to the 
expression.  See the example of the New Group window in the 
previous example (Figure 3-27).  On the left side of the New 
Group window, find Table Name.  Use the dropdown box to 
select a table. 

  Double click the field containing the table you want to use.  It 
will appear in the expression box. 

  Double click an operator.  It will appear in the expression box. 

  Either click the Browse Field Data button, or type in a value 
to complete the expression.  See the following example. 

 

 

 

 

 

 

 

 

Figure 3-29: Sample of screen used to create an expression 
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If you click the Browse Field Data button the Validate from Status 
window appears.  Select the expression you want to use and click 
OK.  You will be taken back to the New Group window. 

 

 

 

 

 

 

 

 

 

 

Figure 3-30: Sample of browsing field data to select an expression 

11. If there will be more than one condition, click either the And or Or 
button to connect multiple conditions together, and repeat the step above 
until your expression is complete. 

 

Figure 3-31: Sample of adding conditions 

12. Click the Check button on the right side of the screen to verify that 
your expression will work.  If it does not work, you will receive an error 
message pointing out what needs to be corrected. 
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Note: It is very important that you click the Check button 
and correct any errors.  If you save a personal alert group 
with an error, your Alert Monitor may crash. 

13. Click the Order By button to choose how the results should be 
displayed in the call group. 

14. Click the first field by which you want to sort the results and the radio 
button for either Ascending or Descending order. 

 

Figure 3-32: Sample of screen used to select order 

15. Click the Add >> button, as shown in the example above. 

16. Repeat the above two steps to add additional sorts.  The second sort will 
sort the list within the first sort’s order, and so on. 

If you need to remove an “order by” parameter, highlight it and click the 
<<Remove button.  To change the sort order, remove the entire 
contents of the “Order by List” and add them back in the correct order. 

17. Click the OK button. 

18. Click the Save button to save your new call group.   

You have completed creating the call group, but now need to add it to 
your list of open call groups. 

19. Click the name of the call group you just created. 
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Figure 3-33: Sample of call group window 

20. Click the Open button as shown in the above screenshot. 

21. In the boxes below the Generate an alert if… prompt, choose from:  

  Any Calls are Found 

  Calls are Added 

  Calls are Removed 

 

Figure 3-34: Sample of generating call group alerts 

22. Click the OK button. 

23. Click the Exit button.  A window for your new Call Group opens 
automatically. 
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24. Click the Save icon.  This saves the new call group to your list of open 
call group alerts. 

25. Click the Start/Stop Polling (traffic signal) icon to turn polling on 
again. 

4.10 Change an Existing Call Group’s Selection 
Criteria  
The following instructions show how to change a Personal Call Group.   

If you need a change made to a Global or Team Call Group, contact the OIT 
Help Desk, or create a ticket to request this service.  In most instances, the 
OIT Help Desk will create a similar call group thereby preserving the existing 
call group for other HEAT technicians. 

4.10.1 Steps 
To edit an existing call group, take the following steps: 

1. Click the Start/Stop Polling (traffic signal) icon to stop the polling for 
new tickets.  Polling must be turned off while working with call groups. 

Remember – when polling is on many of the menu and toolbar options are 
grayed out, as shown in the following example. 

2. Click the Define call group alerts icon.  

 
 

Figure 3-35: Sample of Define call group alerts icon 

3. The Call Group Alert Definitions window appears.  Click the Edit button.   
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Figure 3-36: Sample of screen used to edit an existing call group 

4. The Edit Alert Group window appears.  Click the Browse… button. 

 

Figure 3-37: Sample of screen used to edit an existing call group 

5. The Open Call Group window appears.  Click the Personal radio button 
then click the name of the call group you will be editing. 
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Figure 3-38: Sample of selecting the group to be edited 

6. Click the Edit… button. 

7. Make the necessary changes to the Call Group: 

  Name: You can name a Call Group anything you want. 

  Description: Type a brief description of the Call Group. 

 

Figure 3-39: Sample of editing call group 

 

This box defines the 
conditions that must 
be met for a ticket to 
appear in the Call 
Group. 
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8. To edit the expression text, you may either: 

  Edit the text directly in the expression box. 

  Or, place the cursor in the Expression Text box where you want 
to begin your edits and follow the steps as described in “Create a 
New Personal Call Group.” 

9. Click the Check button to verify that your new expression will work.  If 
not, you will receive an error message pointing out what needs to be 
corrected. 

10. To change the sort order of the results, click the Order By… button, to 
change how the results should be displayed in the call group. 

  To add a field, click the field you want to sort the results by and 
the radio button for either Ascending or Descending order.  Then 
click the Add >> button. 

  To remove a field, click the field you want to remove.  Then 
click the <<Remove button. 

  To change the order of the sort, you will need to remove all the 
“Order by List” entries and add them back in the correct order.   

 

Figure 3-40: Sample of changing the sort order 
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11. If you changed the sort order, click the OK button. 

12. Click the Save button to save the changes you just made to the call group.  

13.  Click the Close button. 

14.  Click the OK button. 

15.  Click the Exit button. 

16.  Click on the Save icon, as shown in the following example 

17.  Click the Start/Stop Polling (traffic signal) icon to turn polling back 
on. 
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5.0 Call Logging:  Step-by-Step Instructions 
This section provides information about Call Logging. 

5.1 Login 
Use the instructions in this section to login to the HEAT Service and Support 
system. 

5.1.1 Steps 
To login to Call Logging, take the following steps: 

1. Double click the Call Logging icon. 

2. If you have an Active Directory network account, you should not have to 
log in.  If your HEAT account does not match your AD account ID, or if 
do not have an AD account, you will have to enter your HEAT User ID 
and Password as shown below.  If your HEAT ID doesn’t match your 
Active Directory ID contact the OIT Help Desk to have your HEAT ID 
modified to match your AD account ID. 

 

Figure 4-1: Sample of logon screen 
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6.0 The Dashboard 
HEAT will open by default to the “Dashboard” utility.  The Dashboard can 
also display information from Broadcasts (messages that impact HEAT 
users). 

Using the tabs in the lower section of the screen, technicians can have a quick 
overall view of different aspects of their work: 

  Active Incidents by Priority 

  Active Incidents by Call Type 

  Total Calls by Month 

 

 

 

 

 

 

 

 

 

 

Figure 5-1: Sample of dashboard screen 

After you have logged into Call Logging, you may have the Dashboard show, 
or close it as you choose.  See the following example. 
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To open or close the Dashboard, go to the menu bar and click View > 
Dashboard. 

 

 

 

 

 

 

 

 

Figure 5-2: Sample of opening or closing dashboard 
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7.0 Tickets:  Step-by-Step Instructions 
HEAT tickets, or call records, are created from within Call Logging.  A 
HEAT ticket consists of four parts: Call Log, Detail, Assignment, and Journal. 
Before a ticket can be saved, essential information must be entered in the Call 
Log, Detail, and Assignment sections.  Journal entries are optional, but 
encouraged because important information about the ticket and actions taken 
can be posted in a journal.  A ticket can have multiple journals.  The 
instructions below are a step by step guide to creating and saving a HEAT 
ticket. 

Note: Customers may also create their own tickets using 
the Help Self Service (HSS) web interface.  While HSS is 
very similar to HEAT’s Call Logging, it does not have all 
the functionality of Call Logging.  It is mentioned here for 
informational purposes and will not be covered any further 
in this document.   

7.1 Steps to Create a Ticket 
To create a ticket, take the following steps: 

1. If in Alert Monitor, click the Launch Call Logging icon. 

 

Figure 6-1: Sample of Launch Call Logging icon 

2. The Call Logging window appears.  From the menu bar, select File > 
New Call Record – or click the New Call Record icon. 

 

Figure 6-2: Sample of New Call Record icon 

3. Type the customer’s Last Name in the Last Name field, and then click in 
any other field. 

  If there is more than one customer in the HEAT database with 
the same last name, the Validate from Profile window will open.  
Choose the correct customer name and click the OK button. 

  If the customer is not listed in the HEAT database, the Validate 
from Profile window appears listing all available customer 
profiles.  If you cannot find a match, contact the OIT Help Desk 
and ask them to create the customer’s profile.  The customer’s 
profile must be created before you can continue with the ticket’s 
creation. 
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  Otherwise, the customer’s information defaults from the 
customer’s profile.  Verify the customer’s information to ensure 
that the correct customer profile was defaulted. 

4. Confirm the customer’s Office, Phone, and E-mail Address.  Update 
them as required by clicking the Customer Profile icon shown following, 
or use the F5 key. 

 

Figure 6-3: Sample of Customer Profile icon 

5. When you select the customer, a history of the customer’s calls will 
appear. 

6. If a call history did not appear, then go to the customer’s call history to 
see if there is already an open ticket for this problem or service request. 

  Click the Caller History icon.  

 

Figure 6-4: Sample of Caller History icon 

  If there is an existing ticket, either update the ticket (or reopen it) 
or abandon this ticket.  Otherwise proceed with the next step. 

  Close the Customer window to return to the call record. 

7. Choose the appropriate Call Type by clicking the dropdown arrow by 
that field.  The majority of the calls will either be a call type of 
“Service” or “Problem.”  See the following table for more information. 
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Call Type For … 

Service • A customer requested modification that impacts a limited number, 
typically 10 or fewer, customers.  

• Examples: 

− Moving desktop workstations 
− Creating Novell accounts 
− Loading software 
− Creating a web page 
− Provision of cellular phones or Blackberries 

Problem • Any unplanned outages, loss of functionality, or malfunctions in the 
software or hardware of an existing system.  

• Impacts one customer or has a minor impact on multiple customers.  

• Examples: 
− Can’t print to a network printer 
− Can’t access e-mail or the network 
− Software doesn’t work properly 
− Web page link is broken 

Change • Planned modification to production hardware or software that 
impacts/supports a significant number of customers – typically more than 
10. 

• Examples: 

− Upgrading servers 
− Installing software to an entire Indian Health Service unit 
− Maintenance of network routers 

Critical 
Problem 

• Unplanned outage or major loss of functionality of production system(s) 
impacting multiple customers.  

• The initial ticket created for a critical problem will have a call type of 
“Critical Problem.”  If other customers call with the same problem, each 
of their tickets will have a call type of “Problem” cross-referencing the 
critical problem ticket.  

Figure 6-5: Table of call types and definitions 

HEAT v8.4 User Guide 40 Ticket Instructions 
October 2008 



Indian Health Service Office of Information Technology       v1.0 

Note: Once you choose a call type, it should only be changed if the 
initial call type was incorrectly selected.  

For example when a ticket is created with a call type of “Critical 
Problem,” you should change its call type to “Problem” if you later 
discover that there is already another Critical Problem ticket 
addressing the same problem.  

Whereas, you should not change a Call Type for example from a 
“Critical Problem” to a “Problem” just to keep the ticket open while 
confirming the effectiveness of the resolution.  The correct action 
for this scenario would be to change the Call Status to 
“Monitoring”, and to enter the Resolution Information Date and 
Time as of when the technician believes the ticket was resolved. 

8. On the Call Log tab, the Call Status field is at the lower left of the 
screen.  It defaults to “Open.”  Accept the default. 

9. Complete the remaining fields as shown in the following example. 

 

 

 

 

 

 

 

 

 

 
Figure 6-6: Sample of Call Log tab in a new ticket created in Call Logging 
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Additional information is provided in the following table. 

Field Value 

Source Choose the source that best describes how the customer requested a 
service or change, or reported a problem.  

Please note you normally would not choose either “ATG” or “HSS.”  
Both of these are for system generated tickets received by e-mail or 
from Help Self Service, respectively. 

Select Support 
Center responsible 
for Customer’s 
Organization 

Choose according to the organization to which the customer belongs.  
Do not make assumptions based on the customer’s location.  
For instance not all customers in the National Museum of Natural 
History are members of NMNH.  If you are not sure, choose “OIT”. 

Description of 
Problem/Request 

Enter a detailed description of the problem or service requested.  
Please do not repeat the customer’s name, call date and time in this 
field as the information is captured elsewhere in the ticket. 

• (Change Tickets Only) Create a journal entry by selecting the 
“Change Ticket Information” quick journal entry and 
answering the related questions.  

Figure 6-7: Table of fields and values 
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10. Click the Detail tab and complete the information.  The Detail tab’s 
contents vary based on the ticket’s Call Type. It is used for all call 
types except “Problem.”  The following table provides additional 
information. 

Call Type Fields 

Service • Service Type. Choose the most appropriate. 

• Service Sub Type. Choose the most appropriate. 

• Date Needed by and Time Needed by.  If the customer does not specify 
a date/time by which they need the service provided, ask.  If the customer 
still does not provide a date/time, leave the fields blank. 

• Date Customer Info Provided and Time Customer Info Provided. 
Leave blank.  The technician should complete these fields after obtaining 
all the necessary information from the customer in order to provide this 
service.  

Problem • Hardware Type.  Choose the type of hardware for which there is a 
problem.  If a hardware problem, that is not included in the list, choose 
“Other.”  If not a hardware problem, choose “Not applicable.” 

• Software Type. Choose the type of software for which there is a 
problem.  If a software problem, that is not included in the list, choose 
“Other.”  If not a software problem, choose “Not applicable.” 

• Critical Problem Related.  Choose “Yes” if there is a critical problem 
HEAT ticket related to this ticket.  Otherwise, choose “No”. 

• Critical Problem Ticket Number.  If you selected “yes” in the previous 
field, enter the ticket’s number.  Otherwise enter “N/A.”  Please note that 
this field does not actually link this ticket with the referenced Critical 
Problem’s ticket number. 

Change • Change Type. Choose the most applicable.  

• Date Scheduled. The planned date for implementing the change. Indian 
Health Service policy requires that all changes apparent to the customers, 
or that will cause an outage must be approved by the CCB.  The affected 
customers must also be notified at least 3 days in advance. 

• Time Scheduled. The planned start time of the change.  

• Est. Completion. This field only needs to be completed when the change 
will take longer than one day to complete. 

• Outage Required. Choose “Yes” if the customer’s service will be 
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Call Type Fields 
disrupted.  If you are unsure, choose “TBD”. 

• Outage Duration. If there will be an outage, enter the length of time for 
the outage in hours and/or partial hours.  For instance 30 minutes would 
be entered as “00.50”. 

• Customer Notification Needed.  

• If change will not be noticeable by the customer and the does not 
require an outage, you may choose “No.” 

• If you are unsure, choose “TBD.”  

• Choose one of the following if the change will not be transparent to the 
customer (e.g. screen changes, or system outage), and attach a draft 
“Change Notification” request form 
(http://ihs.gov/OIT/cssd/customer/forms.htm) to this ticket for review 
by the CCB: 

− “IHS-Wide” will go to everyone. 

− “Targeted Customers” will cover situation when notices only need to 
go to specific units like OIT staff. 

− “IHS-NetMgmt” (a distribution group whose membership includes IT 
support staff across the Institution.) 

− Other when notices need to go to groups like HEAT Trackers, Indian 
Health Service Webmasters, etc.   

• Approval Status. The initial status is “Pending” approval from the CCB.  
This field can only be updated by select staff.  

Critical 
Problem 

• Desc Customer Impact. Enter a brief description that will explain to the 
technician(s) the impact the problem is having on the customers. 

• Hardware Type. Choose the type of hardware for which there is a 
problem.  If a hardware problem, that is not included in the list, choose 
“Other.”  If not a hardware problem, choose “Not applicable.” 

• Software Type. Choose the type of software for which there is a 
problem. If a software problem, that is not included in the list, choose 
“Other.”  If not a software problem, choose “Not applicable.” 

• Impact. Choose the most applicable level of impact to the customers.  
This field is used for categorizing critical problems and their level of 
occurrence in reports. 

 

 

http://ihs.gov/OIT/cssd/customer/forms.htm
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Call Type Fields 
 

• Impacted Organization. Choose the value which best describes the 
units affected by the problem.  

− Multiple. More than one organization is affected.  If you know 
which organizations, list them in the description. 

− See Organization. If the affected organization is the same as the 
customer’s organization for whom this ticket is being created. 

− IHS-Wide. Affecting everyone in the Indian Health Service. 

− Unknown. Aren’t sure which organizations are being affected. 

− Other. If the affected organization is different than the customer’s 
organization and none of the other options apply, list the affected 
organization in the description.  

• Number Impacted. Enter the estimated number of users being impacted 
by the problem.  You may also enter a short text description such as 
“All”.  

Figure 6-8: Table of call types and fields 

11. Click the Assignment tab.  The tab area will come up blank. 

12. Right click the Assignment tab and choose New Assignment.  Complete 
the assignment information. 

 

 

 

 

 

 

 
Figure 6-9: Sample of screen used to enter assignment information 

  Choose the Group to which the HEAT technician belongs who 
will be working the ticket. 

  Choose the HEAT technician from the Contact dropdown list-
box.  The technician’s information defaults. 
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  In the Comments field, enter any information that will be helpful 
for the technician to complete the assignment that is not recorded 
in the “Description of Problem/Request” or does not warrant a 
journal entry. 

13. If more than one technician will need to work this call, create another 
assignment for each technician by repeating Step # 11.   

14. Save the Call Record by going to the menu bar and selecting Save > 
Save Call Record, or click the Save Call Record icon. 

 

Figure 6-10: Sample of Save Call Record icon 

A Call ID (HEAT ticket number) is assigned to the call and is displayed in 
the upper left hand corner of the Call Logging window. 

 

 

 

 

 

 

 

Figure 6-11: Sample of ticket showing assigned Call ID (ticket number) 

15. The next action depends on what you need to do with the call.  The 
following table contains more information. 
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Status Value 
You solved the 
customer’s problem or 
request 

• Give the customer the help desk ticket number. 
• Acknowledge the ticket: 

− On the Assignment tab, right mouse click 
on the Acknowledged by field. 

− Choose Acknowledge. 
• Close the ticket following the steps in Section 

5.10 of this document. 
You assigned the ticket to 
someone else for action 

• Give the customer the help desk ticket number. 
• If this is a critical problem, contact the 

technician(s) via phone to them know about the 
problem and the related ticket number. 

Figure 6-12: Table of status and values 

7.2 Put an Unsaved Ticket on Hold  
Tickets that have not yet been saved can be placed “on hold.  When you place 
a ticket on hold, it allows you to create or open another ticket without first 
completing all the required information.  The maximum number of calls you 
can simultaneously place on hold is 15. 

7.2.1 Steps to Put an Unsaved Ticket on Hold 
To place an unsaved ticket on hold, take the following steps: 

1. Without saving the ticket, choose File > Put Call on Hold from the 
menu bar. 

2. The menu bar shows the number of calls on hold in the Count field.  See 
the following example. 

 

 

 

 

 

 

 

Figure 6-13: Sample of screen used to put a ticket on hold 
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When you place a call on hold, HEAT creates a special “Calls On Hold” 
Call Group.  This group works like any other call group in Call Logging – 
except that the group's calls are only viewable from your computer. 

3. After placing a call on hold, you may either view an existing ticket or 
create a new ticket. 

7.3 Retrieve a Ticket on Hold 

7.3.1 Steps to Retrieve a Ticket Placed on Hold 
To retrieve a ticket placed on hold, take the following steps: 

1. Choose Window > Calls on Hold. 

 

 

 

 

 

 

 

Figure 6-14: Sample of calls on hold window 

2. If more than one ticket was put on hold, click the call record navigation 
buttons located on the toolbar to move between the calls in the Calls on 
Hold call group. 

        

 

 

 

Figure 6-15: Sample of moving between calls 

Note:  Once you save a ticket that has been put on hold, it 
is removed from the “Calls On Hold” Call Group. 

First Call 
Record 

Last Call 
Record 

Previous Call 
Record 

Next Call 
Record 
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7.4 Open 
HEAT tickets may be opened in several ways.  See the Open a Ticket section 
of this document. 

  By the specific HEAT ticket number 

  From a call group (a grouping of tickets generally with the same 
technician or another common attribute) 

  From the alert monitor.   

7.4.1 Steps to Open a Specific Ticket 
To open a specific ticket, take the following steps: 

1.  From the menu choose File > Go To Call ID. 

2. Type the ticket number into Call ID field. 

 
Figure 6-16: Sample of screen used to enter call ID 

3. Click the OK button.  

7.4.2 Steps to Open a Ticket from a Call Group 
1. From the menu choose Group > Open Call Group. 

2. Choose the call group you want to open. 
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Figure 6-17: Sample of Open Call Group window 

3. Click the Open button. 

4. The oldest call record appears first.  Click the call record navigation 
buttons located on the toolbar to move between the calls in the call group. 

 

 

 

Figure 6-18: Illustration of call records 

First Call 
Record 

Last Call 
Record 

Previous Call 
Record 

Next Call 
Record 

7.5 Acknowledge 
The first step in working a HEAT ticket is acknowledging it.  Acknowledging 
the ticket signifies that at a minimum you are aware of its existence. 

Note: Generally, tickets should be acknowledged within 
four (4) hours.  You should use Alert Monitor to obtain 
notices of tickets needing your attention. 

7.5.1 Steps to Acknowledge  
To acknowledge a ticket, take the following steps: 

1. Open the ticket. 

2. Click the Assignment tab. 

3. Click the Acknowledge… button in the lower portion of the Call 
Logging screen. 
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4. A date/time stamp showing when you resolved the assignment is shown in 
the “Acknowledge” field along with your HEAT User ID. 

 

 

 

 

 

 

Figure 6-19: Sample of entering acknowledgement information 

5. Click the Save Call Record icon on the menu bar. 

 

Figure 6-20: Sample of Save Call Record icon 

 

7.6 Resolve an Assignment 
When you have completed your work on the HEAT ticket, you need to 
“resolve” your assignment.  If you did not do any work on the HEAT ticket 
and need to assign it to someone else, follow the steps to “Reassign” the ticket 
(see the Reassign section of this document.) 

Note: Resolving an assignment does not close the ticket. 
After you resolve an assignment, the ticket may remain in 
your Alert Monitor if there are any other open assignments 
depending on how your Alert Monitor set up. 

7.6.1 Steps to Resolve an Assignment  
To resolve an assignment, take the following steps: 

1. Open the ticket. 

2. Before you resolve the assignment, you should add a journal entry to 
document your actions (see the Add a Journal Entry section of this 
document). 

3. Click the Assignment tab. 

4. Click the Resolve… button, located immediately below the 
Acknowledge button.   
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5. The Enter Value window opens.  Click the dropdown arrow, and select 
either Completed or Reassigned as appropriate.  

 

 

 

 

 

Figure 6-21: Sample of entering value to resolve ticket 

6. A date/time stamp stating when you resolved the assignment is shown in 
the “Resolved” field along with your HEAT User ID. 

7. In the Resolution field, choose “Completed.” 

Notes:  If the technician does not need to perform any work 
related to a ticket, including reassigning the ticket, choose 
“Canceled” in the resolution field.  
Conditions that can result in this include (1) customer fails 
to provided need info, so the technician closes the ticket, 
(2) customer cancels a request for service; (3) multiple 
assignments were made and this assignment was 
extraneous. 

8. Click the Save Call Record icon on the menu bar.  

9. At this point you need to decide if the ticket needs to go to someone else 
for a follow-on action, or if the ticket can be closed since all of its 
assignments are resolved. 

10. To create a new assignment, follow the steps in the Create a New 
Assignment section of this document. 

11. To close the ticket, follow the steps in the Close section of this document. 

If there are other open assignments, no further action is required by you once 
you have resolved your assignment. 

7.7 Create a New Assignment 
Each HEAT ticket may be assigned to one or more HEAT technicians.  
Multiple assignments can be created at once, or additional assignments can be 
created at any time to an open ticket. 
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7.7.1 Steps to Create a New Assignment  
To create a new assignment, take the following steps: 

1. Open the ticket. 

2. Click the Assignment tab to bring up that screen.  Then right click it to 
bring up a dropdown menu.  Select New Assignment. 

3. Complete the Assignment Information fields. 

 

 

 

 

 

 

Figure 6-22: Sample of entering assignment information 

4. Choose the Group to which the HEAT technician belongs who will be 
working the ticket. 

5. Choose the HEAT technician from the Technician dropdown list-box.  
The technician’s information defaults. 

6. If more than one technician will need to work this call, create another 
assignment for each technician by repeating the above steps. 

Note:  Important details about the assignment should 
always be included in a journal entry.  Section 6.11 Add a 
Journal Entry provides instructions. 

You may abandon changes to the current assignment by clicking the 
Abandon Changes icon, located on the menu bar.  This will also 
abandon any changes you made to the ticket since it was last saved.  
Note the following example of the icon. 

 

Figure 6-23: Sample of Abandon Changes icon 
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7. Click the Save Call Record icon to save your work. 

 

Figure 6-24: Sample of Save Call Record icon 

7.8 Reassign 

Note:  Never reassign a ticket by selecting a new name 
from the Technician field on the Assignment tab.  The steps 
described below should always be followed to ensure that 
an audit trail is maintained on a ticket’s assignments. 

There are only two reasons when you would reassign a ticket to someone else: 

  A ticket is assigned to you by mistake. 

  The only action you are taking on the ticket is to assign it to someone 
else for action.  For example: 

o Supervisors may choose to have the all tickets in their area 
assigned to them and then they’ll assign them to their staff. 

o One technician may reassign a ticket to a coworker with the 
same job duties whose workload is currently lighter. 

If the ticket was correctly assigned to you and you have finished your 
assignment, do not reassign it to someone else.  Instead you should “resolve” 
your assignment (see Resolve an Assignment section of this document) and 
create a new assignment (see the Create a New Assignment section). 

7.8.1 Steps to Reassign a Ticket to Someone Else  
To create a new assignment, take the following steps: 

1. Open the ticket. 

2. Click the Assignment tab. 

3. Click the Resolved button. 

 

Figure 6-25: Sample of Resolve button 

4. When the Enter Value window appears, use the dropdown arrow to 
select the appropriate resolution code.  Select Reassigned.   
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5. Click the Validate button.  The Validate from Resolved window 
appears, showing the resolution and description.  Click OK. 

6. You will be returned to the Enter Value window.  Click OK. 

7. If you are reassigning the ticket to another group because it was assigned 
to you error (versus to another member of your group), create a journal 
entry explaining the reason for the reassignment. 

8. Click the Save Call Record icon located on the menu bar.  

9. Create a new assignment following the steps in the Create a New 
Assignment section of this document. 

Note:  If a ticket was assigned to you in error and you do 
not know to whom it should be assigned, reassign the ticket 
to the OIT Help Desk Manager.  Please include in the 
Comments that “This ticket was assigned to me by mistake 
and I don’t know to whom it belongs.  Please reassign.” 

7.9 Place Holder: Change a Ticket’s Status to 
Monitoring 
.. 

7.10 Update 
After a ticket is saved you may update any of its information on the call log 
and detail tabs.  In fact, you should regularly update the “Status/Solution” 
field to keep the customer informed of the ticket’s progress.  More details are 
provided in this section. 

7.10.1 Steps to Update a Ticket’s Status and Information  
To update a ticket’s status and information, take the following steps: 

1. Open the ticket. 

2. Update the ticket’s information. 

The following table provides additional information. 

3. Click the Save Call Record icon located on the menu bar.  
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Update the… Guidance 

• You may update or correct any information on this tab. 

• If you are correcting information, add a journal entry briefly describing 
the correction. 

• It may be appropriate to update the Call Status before closing a ticket.  

− Choose “Deferred” if further action on the ticket must wait until 
another action is completed, or the ticket is pending a decision. 

− Choose “Monitoring” when you want to check the effectiveness of 
a ticket’s resolution before closing the ticket, and enter the 
Resolution Information Date and Time as of when the technician 
believes the ticket was resolved. 

• Resolution Information: Enter the date and time when the technician 
believes to have resolved the problem. This may be different than the 
date and time when the ticket is closed – especially if the ticket was 
being monitored. 

Call Log tab 

• The Status/Solution is the primary field that the customer refers to in 
Help Self Service to check a ticket’s status. 

− Update it regularly to show progress on the ticket. 

− Use it to explain ticket dependencies such as waiting for 
completed request form from the customer. 

− When you update it, place your initials in parenthesis (e.g., (abc)) 
at the end of the comment so that other technicians and trackers 
will know who entered the update. 

− When updating the Status/Solution, it is always a good idea to cut-
and-paste the contents of the Status/Solution into the Journal – 
especially for time critical or sensitive information. 

− This extra step may help prevent problems later on if the 
status/solution is accidentally erased or modified. 

Detail tab • You may update or correct any information on this tab. 

• For service tickets, the technician should update the Date Customer 
Info Provided and Time Customer Info Provided fields.  

• If additional information was required before the service could be 
provided, enter the date and time when that information was 
obtained.  
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Update the… Guidance 
• Otherwise if all the needed information was provided when the 

ticket was opened, enter the ticket’s original date and time.  

• Do not enter the close date and time. 

• If you are correcting information, add a journal entry briefly describing 
the correction. 

Assignment tab • Never change the technician.  If an assignment was made in error, 
follow the steps to reassign the ticket as described in the Reassign 
section of this document. 

Journal tab • Add detailed information about the ticket and progress. 

 

7.11 Add a Journal Entry 
Journal entries are used to record information such as additional customer 
provided details, status updates, resolutions, or notes for the next technician. 

Once a journal entry is saved, it cannot be changed.  Therefore journal entries 
are a very good place to put information as a matter of record.  

7.11.1 Steps to Add a Journal Entry  
To add a journal entry, take the following steps: 

1. Open the ticket from the Call Logging window. 

2. Click the Journal tab. 

3. Go to the Journal Type box.  Click the dropdown arrow to select from a 
list of recognized journal entry types. 

4. Type a comment describing the action you took, and complete the journal 
entry as shown in the following example.  You may also edit existing 
journal entry text. 
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Figure 6-26: Sample of creating a journal entry 

5. To run spell check on your journal entry, right mouse click in the Journal 
Entry area and choose Spell Check from the menu that appears.  The 
spell check works similarly to other spell checks by identifying words not 
in its dictionary.  You may choose a replacement word, ignore the word, 
or type a new word. 

 

Figure 6-27: Sample of selecting Spell Check 

If necessary, you may abandon changes to the current journal entry by 
clicking the Abandon Record icon, located in the menu bar at the top of 
the screen.  

 

Figure 6-28: Sample of Abandon Record icon 

Note:  This will also abandon any changes you made to the 
ticket since it was last saved. 

6. Click the Save Call Record icon, or go to File > Save Call Record.  
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7.12 Close 
Once all of a ticket’s assignments are resolved, the ticket needs to be closed 
by the last technician. 

Note:  Do not close the ticket until you are finished adding 
all the information to it (e.g. journal entries).  Once a ticket 
is closed, its information cannot be changed without 
reopening the ticket. 

7.12.1 Steps to Close a Ticket  
To close a ticket, take the following steps: 

1. Open the ticket. 

2. Go to the Call Log tab.  Make note all of the current Solution Description 
entries which show the progress of the ticket as it was being worked, and copy 
them into a journal entry. 

  Highlight the Solution Description text. 

  Press the Ctrl key with the c key to copy the text. 

  Click the Journal tab. 

  Copy this final Solution Description text into a journal entry. 

  Enter the final solution or resolution into the Solution Description field. 

o Click within the Journal Entry box and press the Ctrl key with 
the v key to add the solution text. 

o For problems, include the detail about the cause of the problem 
(if known) and the steps used to solve it. 

Copying the solution description text to the journal ensures that the 
information you entered will not be lost during future ticket updates – such as 
reopening a ticket. 
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Closing Service Tickets 

For service tickets, click the Detail tab to display the Critical 
Problem Detail Screen, and update the information there. 

If additional information was required from the customer before 
the service could be provided, use the Customer Impact 
Description box to include the date and time when that 
information was obtained.  

Otherwise if all the needed information was provided when the 
ticket was opened, use the ticket’s original date and time.  

Do not enter the close date and time in these fields. 

3. Click the Call Log tab. 

4. Go to the lower right of the Solution Description area.  In the UVF (User 
Verified the Fix) field, click the dropdown arrow and select the option that 
best indicates whether the customer verified to you that the fix or 
resolution met their expectations (N/A, Yes, or No). 

Note:  Every effort should be made to contact the customer 
to verify that the ticket was completed satisfactorily.  
Whenever possible, contact the customer in person or via 
phone.  Otherwise, contact the customer through e-mail. 

Document each contact attempt as a journal entry in the 
ticket.  If after three tries, conducted on separate days, the 
customer has failed to respond, close the ticket and list 
UVF as “no”. 

5. In the Incident Cause field, choose the most appropriate reason for the 
initial ticket. 

  “Failure” when the problem was due to hardware failing or a bug found 
in the software. 

  “Request” when the ticket is a service request initiated by the customer. 

  “Scheduled work” when the ticket is a service request for regularly 
scheduled maintenance activities. 

  “User Error” when the user made a mistake or did not know how to use 
the hardware or software.  Usually training should be provided to the 
customer to prevent the problem from reoccurring. 
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  “Virus” when the problem was due to a confirmed virus infection.  

  “Other” for any other cause. 

6. In the Reason for Closure field, choose from the following: 

  “Completed” when the problem or service request was completed. 

  “Invalid Ticket” when the ticket was created in error.   

  “Canceled by Technician” should only be selected when the assignment 
cannot be accomplished due to technical or budget constraints.  The 
technician must contact the customer to explain why the ticket was 
closed, and whenever possible help identify alternatives the customer 
can explore to satisfy their needs. 

  “Redirected Customer to …” is selected when the responsible staff for 
fulfilling the problem or service request is not a technician in the OIT 
maintained HEAT database. 

  Otherwise, choose the most appropriate reason for the ticket not being 
completed as described in the “description of problem/request.” 

7. In the Resolution Information area, enter the date and time details of when 
the technician believes the ticket was actually resolved, for example the 
date and time prior to being put in monitoring status.  Otherwise, enter the 
current date and time. 

8. Go to the Milestones area in the lower right of the screen.  At Closed By 
enter the date and time. 

9. The ticket Status will automatically change to Closed when the ticket is 
closed. 
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Figure 6-29: Sample of closed ticket 

10. HEAT checks the ticket’s contents to see if all the assignments have been 
resolved and all the mandatory fields completed.  If not, a message box 
will remind you of either required fields or actions that must be completed 
before you can close the ticket.  Once all the requirements are met, you 
will be able to successfully close the ticket. 

11. Confirm that the Call Status is “Closed.” 

12.  Remember to save your work.  Click the Save Call Record icon. 
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7.13 Reopen a Ticket 
A closed ticket can be reopened when it was closed erroneously, additional 
information needs to be added to the ticket, or the customer does not feel it 
was resolved.   

In addition after a customer has verified a fix, problem and critical problem 
tickets should only be re-opened if the problem reoccurs on the same day as 
when the ticket was initially marked resolved.  Otherwise, create a new ticket 
and reference the old ticket number. 

Notes:  The steps described below must be followed when 
reopening a ticket to move the ticket’s status information to 
a journal entry in the ticket.  Otherwise the contents of the 
status will be lost. 

7.13.1 Steps to Reopen a Ticket  
To reopen a ticket, take the following steps: 

1. Open the closed ticket. 

2. Choose File > Reopen Call Record. 

3. Click the Yes button to move the status to a journal entry.  Otherwise, the 
old status information could be lost. 

 

Figure 6-30: Sample of moving status to a journal entry 

4. A journal entry is created showing the date and time that the ticket was 
originally closed, the technician that originally closed the ticket, the reason 
for the closure, and the solution description. 

5. At the top of the screen, the status of the call is now “Reopened.” 

6. Create a journal entry explaining the reason for reopening the ticket.  

7. If you do not plan to immediately close the reopened ticket, create a new 
assignment for the ticket. 
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8. Click the Save Call Record icon. 

9. If you are finished updating the ticket and no further action is required, 
close the ticket as described in the Close section of this document. 

7.14 View Activity for a Ticket 
HEAT tracks all the activity (or history) of each ticket in an Activity Log.  
This log shows details such as when the call status changed or the call type 
change.  In addition, it identifies the user who made the change along with the 
date and time. 

7.14.1 Steps to View Activity Log 
To look at a ticket’s history, take the following steps: 

1. Open the ticket. 

2. Go to View > Activity Log from the menu bar, or click the Activity Log 
icon at the bottom right of the screen. 

 

 

 
 

 

 

 

Figure 6-31: Samples of activity log for a particular call ID, and activity log icon. 

3. For more information on the column headings, click the Help button. 
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8.0 Customer Information:  Step-by-Step 
Instructions 
HEAT stores information about each customer as a customer profile.  This 
information is accessed each time you create a ticket for a customer.  At the 
Indian Health Service, generally only HEAT Administrators may create new 
customer profiles.  However all HEAT trackers may view this information, 
make updates, and review the call history of a customer. 

Note:  Do not create a ticket just to look up a customer’s 
information, and later abandon it.  Abandoned tickets are 
also assigned ticket numbers.  Instead follow the steps 
defined in this section. 

8.1 View a Customer Profile 

8.1.1 Steps to View a Customer Profile 
To look at a customer profile, take the following steps: 

1. From the Call Logging menu, choose Customer > Search. 

2. The Profile Search window appears.  For the Customer Type choose 
Employee.  

3. Enter your search criteria following one of the examples below. 

4. Click the Search button. 

Examples 
The examples show using the “like” operator.  “Like” searches for matches 
that begin the same as the value you entered.  If you have a high level of 
confidence in your search criteria, you may use the “=” equal operator to find 
only exact matches. 

HEAT ID Search 
To search based on the HEAT ID, enter the search criteria where: 

o Field  = Profile.CustID 

o Operator = like 

o Value = <enter the customer’s HEAT ID> 
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Figure 7-1: Sample of entering search criteria 

Last Name Search 
To search based on the last name, enter the search criteria where: 

o Field  = Profile.LastName 

o Operator = like 

o Value = <enter the customer’s last name or the first few letters 
of the last name> 

 
Figure 7-2: Sample of entering search criteria 
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Unit Search 
To search based on a unit, enter the search criteria where: 

o Field  = Profile.Organization 

o Operator = like 

o Value = <Click the Browse… button to select one of the 
available units> 

 

Figure 7-3: Sample of entering search criteria 

8.2 Display a Customer’s Ticket History  
In HEAT, you can easily view all of a customer’s past and current tickets.  
This is especially helpful for verifying that the current problem or service 
request wasn’t previously reported.  It also allows you to see if this is a 
recurring problem and review the past actions taken to resolve the problem. 

8.2.1 Steps to View a Customer’s Ticket History 
To look at a customer’s ticket history, take the following steps: 

1. If you are currently viewing a new or existing ticket for the customer, 
click the Customer Profile icon.  Otherwise go to the menu bar and select 
View > Profile. 

 

Figure 7-4: Sample of Customer Profile icon  
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2. Click the Call History tab. 

 

 

 

 

 

 

 

 
 
Figure 7-5: Sample of screen used to view call history 

3. To sort the tickets, click the column heading by which you want the 
results sorted.  For example, you could click the RecvdDate column to 
view the most recently opened tickets. 

4. To view a ticket, double click the ticket number. 

8.3 Update a Customer Profile 
In HEAT, you can update an existing HEAT Profile.  However the addition of 
new customers can only be done by the HEAT System Administrators.  If you 
come across a customer who is not listed in HEAT, please contact the OIT 
Help Desk. 

Please note that customer’s may also update their profile information 
themselves from within Help Self Service (HSS). 

8.3.1 Steps to Update a Customer Profile 
To update a customer profile, take the following steps: 

1. If you are currently viewing a new or existing ticket for the customer, 
click the Customer Profile icon, or go to the menu bar and select View > 
Profile. 

2. Go to the Profile tab.  Here you may update all the information, except the 
HEAT ID. 

3. Click the Save Customer Record icon to save the updates. 
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9.0 Searches and Reports:  Step-by-Step 
Instructions 
The Difference between Searches and Reports 
Searches allow you to locate one or more tickets that match the criteria you 
define.  The results of searches are displayed online and normally allow you to 
view a ticket online. 

Reports are similar to searches in that they also allow you find tickets that 
match specific criteria.  However, reports are printed and not viewed online.  
In addition, reports support more complex search criteria.  Standard and 
custom reports are available in HEAT.  

9.1 How to Request a New Report 
If you require a custom report, submit a request to the OIT Help Desk 
outlining your requirements.  If there is a similar standard or custom report, 
please reference it in your request noting any required modifications required 
to meet your needs. 

9.2 Simple Search 
A Simple Search can quickly find a ticket by searching for all tickets with a 
common feature, such as Software or the name of a technician.  

Normally simple searches are done when a tracker or technician is viewing an 
existing ticket and wants to see more like it.  “More like it” would be any 
tickets that match one (1) condition, such as the same System, technician, or 
hardware type.  Most of the fields have this search feature. 

9.2.1 Steps to Conduct a Simple Search 
To conduct a simple search, take the following steps: 

1. With a ticket open, right click the field on which you want to base your 
search. 

  If you start your search from a blank ticket or an existing one that was 
not opened as part of a call group, the entire HEAT database will be 
searched. 

2. A menu appears.  Choose Simple Search... 
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3. The simple search window opens automatically displaying the same Value 
that was in the ticket from which you began the search.  You will see that 
in the following example Office is the field on which the sort was based. 

  If you start your search from a ticket that is part of a call group or search 
results (a temporary call group), only the tickets in the call group will be 
searched when Narrow an open call group is checked. 

 

 

 

 

 
Figure 8-1: Sample of simple search options 

4. If you want to search for another value in this field, delete the contents in 
the Value field and click the Browse… button to select another value.  

5. Click the Run button.  The total number of matches found is displayed in 
the Count field of the window title bar. 

6. HEAT displays the last ticket it found that matched your search criteria.  
Note the information displayed in the following example of the Call 
Logging screen.   

 

 

 

Figure 8-2: Sample of ticket found with search 

You can navigate through all the matches using the call record navigation 
buttons located on the toolbar to view the other matches. 

 

 

 

 
Figure 8-3: Illustration of using call record navigation 

First Call 
Record 

Last Call 
Record 

Previous Call 
Record 

Next Call 
Record 
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If you would like to view a summary of each of the tickets found, from the 
menu bar go to Group > Call Record Browse.   

The Call Record Browse window opens, summarizing all the tickets found 
during the search.  Double-click on any call ID to go to the ticket. 

 

 

 

 

 

 

 

Figure 8-4: Sample of window showing summary of tickets found in search 

8. To start a new search of the entire HEAT database, repeat the simple 
search, but uncheck the Narrow an open call group option. 

 

 

 

 

 

Figure 8-5: Sample of simple search of entire database 

With HEAT 8.4 you also have the option of creating a new call group each 
time you refine a simple search.  This allows you to keep your previous 
search results in the current call group.  To use this option, check both 
Create a new call group and Narrow an open call group in the Simple 
Search window. 
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Figure 8-6: Sample of creating a call group for the search and narrowing a call group 

9.3 Run a Canned Report 
Canned reports are created by the HEAT System Administrator using Crystal 
Reports.  You are welcome to run any of these reports for your own use.  

If you will need a report that is not listed, please contact the OIT Help Desk to 
request a new report.  If an existing report is similar to what you need, please 
include its name and what changes need to be made.  This should help speed 
up your request. 

Note:  HEAT trackers will no longer have to login as 
“heatatch” or map to a specified drive (sometimes 
referred to as the T: drive) to access attachments or reports. 

If you run reports from the call logging screen, you may 
want to manually map to that file store:   
<file address/location here>.   

This is only necessary if you run reports by choosing “Run 
Crystal Reports” from the Report menu choice in Call 
Logging.  If you choose “Manage Reports” from that menu, 
this is not necessary. 
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9.3.1 Steps to Run a Canned Report 
To run a canned report, take the following steps: 

1. From the Call Logging menu, choose Report > Run Crystal Report … 

 

Figure 8-7: Sample of screen used in running reports 

2. Click the Browse… button. 

3. Navigate to the <file address/location here> folder, mapped as the U: drive 
in the following example. 
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4. Browse for the report you want to run.  Choose the report and click the 
Open button. 

 

Figure 8-8: Sample of screen used in running reports 

5. Choose where to Print the report: 

  Preview in window.  View the report online with the option to print it. 

  Send to printer.  Print the report to a printer of your choice. 

  Export to file, application, etc.  Save the report as a file in the format of 
your choice (e.g., Excel, Word, PDF) and to the directory of your 
choice. 
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Figure 8-9: Sample of screen showing various print options 

6. Click the OK button. 

7. Type the Password “oitheat”. 

 

Figure 8-10: Sample of password screen 

8. Click the OK button. 

9. If exporting the file, choose the type of file Format (e.g., PDF, Excel, 
Word, HTML).  Accept the default Destination of “Disk file.”  Then click 
the OK button.  You will be prompted to select any formatting options and 
then a destination folder and file name. 
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Figure 8-11: Sample of export window 

10. If prompted for any report parameters, enter the values for each parameter 
in the Discrete Value field.  If a ticket number is requested, be sure to 
include all leading zeros as shown in the example below.  Then click the 
OK button. 

 
Figure 8-12: Sample of entering parameter values 

11. If printing the report, confirm the information in the dialog box.  Make 
any necessary adjustments and click the OK button. 

 
Figure 8-13: Sample of print window 

HEAT v8.4 User Guide 76 Searches & Reports Instructions 
October 2008 



Indian Health Service Office of Information Technology       v1.0 

HEAT v8.4 User Guide 77 Searches & Reports Instructions 
October 2008 

Note:  By default your system printer is selected.  If you 
want to print the report to different printer, click the Cancel 
button and change your default Windows printer.   

To change your default Windows printer:  

1. From the Windows Start menu, choose Settings > Printers and 
Faxes. 

2. Right mouse click on the printer to which you want to print your 
HEAT reports, and choose Set as Default Printer. 

Another option is to repeat the steps to run a canned report but “export the 
file” in PDF format to the file location of your choice.  You can then open 
the PDF and print it from within Acrobat. 
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10.0 Attachments:  Step-by-Step Instructions 
You may attach one or more files or URLs to a ticket.  In order for all 
technicians to view the attachments, the files must be located in a directory 
accessible by all HEAT technicians.  The OIT Help Desk created the 
\\heat1\attachments directory for this purpose.  After you map to this 
directory, you will need to log into it each time you log into the network. 

Because the attachments are part of the HEAT ticket, it is important that they 
are not removed from this directory either by accidentally deleting, replacing, 
or renaming an attachment.  Safeguards have been put in place to prevent this 
type of accident.  However, technicians should also follow these basic rules: 

  Unique Name: Make each attachment’s name unique by naming it with 
the ticket’s number as well as a short description. 

  Journal Entry: Each time you add or modify an attachment create a 
journal entry in the ticket describing your actions for auditing purposes. 

10.1 Attach a File 
 

Notes:  Before you can attach files to a HEAT ticket, it is very 
important that you map a network drive:  

\\IHS-HEATAPPS\attachments.   
You only have to do this once. 

The instructions on how to “Map to the HEAT Network Drive” 
are described in the Map to the HEAT Network Drives section 
of this document. 
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10.1.1 Steps to Attach a File to a Ticket 
To attach a file to a ticket, take the following steps: 

Note:  Beginning with HEAT Version 8, do not manually 
copy a file to the HEAT attachments directory.  Instead, 
HEAT will automatically do this for you. 

1. Open the call record to which you are adding the attachment. 

2. Click the Display Attachment Bar Menu icon in the lower left corner 
of the Call Logging window. 

 

 

 

 
Figure 9-1: Sample of attachment bar icon 

3. From the pop-up menu, choose Add Attachment. 

 

 

Figure 9-2: Sample of selecting Add Attachment 

4. In the Enter New Attachment Information for Call ID #xxxxxx window 
take the following actions: 

  Type a brief Description of the attachment (maximum of 26 characters). 

  Check the Copy Attachment box.  This is required to save a copy of 
the file on the HEAT Attachment directory allowing other people to open 
the attachment. 
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  Click the Browse button to locate the complete File Name (URLs may 
also be entered). 

 

Figure 9-3: Sample of entering new attachment information 

5. Click the OK button.  The attachment appears on the Attachment Bar. 

 

 

 

 
Figure 9-4 Sample of window showing attachment 

6. Add a journal entry to the call record documenting the name and source of 
the attachment that was just added.  This creates an audit trail in case 
something accidentally happens to the attachment. 

10.2 View an Attachment 

10.2.1 Steps to View a Ticket’s Attachments 
In order to look at the attachments for a ticket, take the following steps. 

1. Open the ticket call record that contains the attachment. 

2. Click the attachment’s button located on the Attachment Bar, as shown in 
the previous example.  It may take a few seconds for the attachment to 
open. 
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10.3 Attachment Not Found 
If you receive an error message that an attachment is not found, contact the 
OIT Help Desk to have them reattach the attachment.  You will need to 
provide the following: 

  Ticket number  

  Name of the attachment that is missing. 

10.4 Edit an Attachment 
Due to access controls implemented with HEAT 8, you cannot edit an 
attachment’s description or location.  

  To change the file that is attached, create another attachment (see the 
Attach a File section of this document) with a unique file name and attach 
it to the ticket. Please remember to add a journal entry briefly 
summarizing the reason why the updated attached file was added.  

  To change an attachment’s description, contact the OIT Help Desk to 
have the description updated.  You will need to provide the ticket number 
and both the old and new description for the attachment. 

10.5 Remove an Attachment 

10.5.1 Steps to Remove an Attachment 
In order to remove an attachment from a ticket, take the following steps. 

1. Contact IHS OIT User Support and ask for the attachment to be removed. 

2. Add a journal entry describing why the attachment was removed. 
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10.6 Map to the HEAT Network Drives 
HEAT trackers will no longer have to login as “heatatch” or map to a 
specified drive (sometimes referred to as the T: drive) to access attachments.  
We have configured the HEAT application to automatically use the correct 
file location for attachments.  If you need to search this folder manually, you 
can map to the following UNC:  \\ihs-heatapps.ihs.gov\Attachments. 

If you run reports from the call logging screen, you may want to manually 
map to that file store: \\ihs-heatapps.ihs.gov\Reports.  This is only necessary if 
you run reports by choosing “Run Crystal Reports” from the Report menu 
choice in Call Logging.  If you choose “Manage Reports” from that menu, this 
is not necessary. 

To map a drive, go to My Computer or start Windows Explorer.  Choose 
“Map Network Drive” from the Tools menu in either. 
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11.0 AutoTasks:  Step-by-Step Instructions  
AutoTasks are created by the Indian Health Service HEAT System 
Administrator for your use.  AutoTasks automate routine or repetitive actions.  
This makes HEAT easier and faster to use by HEAT Trackers and technicians.  
You can also place an AutoTask button on your toolbar to make it even easier.  

This chapter includes directions on how to use AutoTasks.  If these examples 
give you ideas for additional AutoTasks, create a service ticket to submit your 
request to the HEAT system administrators. 

11.1 AutoTask: Change Ticket Status to Monitoring 

11.1.1 Place Holder: Steps for AutoTask to Change Ticket 
Status to Monitoring 

11.1.2 Place Holder: AutoTask: Open HEAT User Guide  

11.1.3 Place Holder: AutoTask: E-mail a Customer Prompt 

11.2 Add an AutoTask to Your Toolbar 
You can add any of the AutoTasks to your toolbar in HEAT. 

11.2.1 Steps to Add an AutoTask to Toolbar 
To add an AutoTask to your toolbar take the following steps: 

1. From the menu, choose AutoTask > Manage AutoTasks, and the 
Manage AutoTasks window appears. 

2. In the View section, select All. 

3. Click once to select the AutoTask you want to add to your toolbar. 

4. Click the Associated Toolbar Button in the lower right area of the 
window, as shown in the following example. 
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Figure 10-7: Sample of Manage AutoTasks window 

5. Choose the icon of your choice.  See the following example. 

6. Click the OK button.   

 

Figure 10-8: Sample of selecting an icon 

7. You will be returned to the Manage AutoTasks window.  Click the Close 
button, and the icon appears on the right side of your toolbar.   
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Figure 10-9: Sample of toolbar with newly chosen icon 

11.2.2 Steps to Remove an AutoTask Button from Toolbar 
To remove an AutoTask button from the toolbar take these steps: 

1. Right mouse click the button you want to remove and choose 
Customize. 

2. With the customize window opens, drag the toolbar button off the toolbar. 

3. Click the Close button. 
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12.0 Tips and Tricks  
12.1 Shortcut Keys: Call Logging 

With the cursor located in a field, you may press the shortcut keys to take the 
desired action. 

Action Shortcut Key 
Clear a date or time field F2 
Fill in System Date or Time 
(while in a date or a time field) 

F3 

Display Calendar (while in a date field) F4 
Display all the allowable values for a field F9 
Go to the Call ID Ctrl+G 
New Assignment Ctrl+A 
New Call Ctrl+N 
New Journal Ctrl+J 
Put a Call on Hold Ctrl+H 
Quick Close F10 
Save Ctrl+S 
Spell Check (the current field) Shift + F9 

Figure 11-1: Table of actions and shortcut keys 

12.2 Navigation Keys: Call Logging 
Press the shortcut keys to quickly move between tickets, or a ticket’s tab. 

Action Shortcut Key 
Previous Call F7 
Next Call F8 
First Call Shift+F7 
Last Call Shift+F8 
Call Log Alt+1 
Detail Alt+2 
Assignment Alt+3 
Journal Alt+4 

Figure 11-2: Table of actions and shortcut keys 
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12.3 Shortcut Keys: Alert Monitor 
While in Alert Monitor, you may press the shortcut keys to take the desired 
action. 

Action Shortcut Key 
Define a Call Group Alert CTRL+G 

Define a System Message Alert CTRL+M 

New Alert Definition CTRL+N 

Open a Call Group Alert Definition CTRL+O 

Poll Now F5 

Save CTRL+S 

Start/Stop Polling 
(toggles back and forth) 

F2 

View Alert Summary F8 

View Journal Entries CTRL+J 

Figure 11-3: Table of actions and shortcut keys 

12.4 Spell Check 
In Call Logging, you may spell check any text entry field.  Unfortunately, Call 
Logging only allows you to spell check one field at a time.  At a minimum, we 
recommend that you spell check the “Description of the Problem/Request”, 
“Status/Solution”, and all journal entries. 

12.4.1 Steps to Spell Check a Field 
To spell check the contents of a field take the following steps: 

1. Place the cursor in the text field you want to spell check. 

2. Click the Spell Check icon. 

Please note that only some of the fields have the spell check option.  If a field 
does not have the spell check option, the Spell Check icon on the toolbar will 
be grayed out. 

 
 

Figure 11-4: Sample of spell check icon 
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Spell Check feedback and options for correction will be provided, as shown in 
the following example. 

 

Figure 11-5: Sample of Check Spelling window 
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13.0 Troubleshooting  
13.1 Cannot Update a Ticket 

A ticket cannot be updated when its status is “Closed.”  If you need to make 
an update to a closed ticket, please follow the steps in the Reopen a Ticket 
section of this document.  This section describes how to reopen a ticket. 

However if the ticket’s status is anything other than “Closed” (e.g., open, 
monitoring, or reopened), and you cannot update the ticket or select any 
dropdown menus, then the ticket has most likely been locked by the HEAT 
server.  Contact the OIT Help Desk to request that the ticket be unlocked by 
the HEAT System Administrator. 
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14.0 Glossary of Terms and Definitions 
Term Definition 

Abandon To cancel the creation of a ticket or changes to a ticket (e.g., 
journal entries or assignments) that have not yet been saved.  

AD Active Directory 

AIS An assemblage of hardware, software, firmware, or any 
combination of these, configured to accomplish specific 
information-handling operations, such as communication, 
computation, dissemination, processing, and storage of 
information.  This includes computers, networks, or other 
electronic information handling systems, and the associated 
equipment. 

Alert Monitor The software application in HEAT that notifies technicians of 
tickets requiring their attention.  Tickets may also be opened from 
within Alert Monitor. 

Assignee Technician.  A person responsible for an action on a help desk 
ticket. 

Call Group A collection of tickets that generally have something in common.  
For instance, all open tickets, or all the tickets assigned to the 
same person. 

Call ID A unique reference number assigned by HEAT to a help desk 
ticket.  

Call Logging The core software application of the HEAT system used to log, 
track, and resolve help desk tickets (calls).  It also provides a 
database for queries and reporting.  

Call Record The term that HEAT uses to refer to a help desk ticket.  See 
Ticket. 

Customer Record An important component of Call Logging that contains 
information about customers including their call history. 

HEAT Board A centrally located bulletin board in HEAT’s Call Logging used 
to post general messages of interest to other technicians (for 
instance the status of a system outage) and to link related tickets 
to one another. 
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Term Definition 

Help Self Service 
(HSS) 

A web-enabled HEAT interface that allows customers to enter 
their own service request or problem tickets.  Customers access it 
directly through PRISM:  www.ihs.gov/helpdesk/  

iHEAT A web-enabled HEAT interface that allows technicians to check 
and work their HEAT tickets from any computer with access to 
PRISM. 

Journal Entry A permanent memo field used to record important information 
about a ticket – including its status/solution. 

Orphan Ticket An orphan ticket is an open ticket that does not have any active 
assignments.  Either all the assignments were resolved and the 
ticket was never closed; or, the ticket was never assigned to 
anyone. 

Technician A person responsible for an action on a help desk ticket. 

Ticket Contains the complete history and status of a customer service 
request, problem, critical problem, or change request.  Tickets are 
used to assign, track, record, and report on an individual ticket’s 
progress.  

UVF User verified the fix. 
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15.0 Contact Information 
If you have any questions or comments regarding this distribution, please contact the 
OIT User Support (IHS) by: 

Phone:   (505) 248-4371 or (888) 830-7280 

Fax:   (505) 248-4297 

Web:   http://www.ihs.gov/GeneralWeb/HelpCenter/Helpdesk/index.cfm 

E-mail:  support@ihs.gov   
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